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1. INTRODUCTION

1.1. SCOPE AND FIELD OF APPLICATION

This document is the DICOM Conformance Statement for Synapse
Dose. The purpose of this document is to describe how the application collaborates in a DICOM network
with other Medical Imaging applications that conform to the DICOM 3.0 standard.

1.2. REFERENCES

See Digital Imaging and Communications in Medicine (DICOM), parts 1 through 12 (NEMA PS 3.1-12).

1.3. DEFINITIONS

See Digital Imaging and Communications in Medicine (DICOM), parts 1 through 12 (NEMA PS 3.1-12).

1.4. SYMBOLS AND ABBREVIATIONS

Definitions, terms and abbreviations used in this document are defined within the different parts of the
DICOM standard.
Abbreviations and terms are as follows:

AE DICOM Application Entity

AET Application Entity Title

DICOM Digital Imaging and Communications in Medicine
DIMSE DICOM Message Service Element

GSDF Grayscale Standard Display Function

HIS/RIS Hospital Information System / Radiology Information System.
IHE Integrating the Healthcare Enterprise

IHE-TF Integrating the Healthcare Enterprise Technical Framework
IAN Instance Availability Notification

I0D Information Object Definition

ISO International Standard Organization

PDU DICOM Protocol Data Unit

LUT Look-up Table

MPPS Modality Performed Procedure Step

MWL Modality Worklist

P-LUT Presentation Look-up Table

Q/R Query Retrieve

SCP Service Class Provider

SCU Service Class User

SCN Study Content Notification

SOP DICOM Service-Object Pair

TCP/IP Transmission Control Protocol/Internet Protocol
TLS Transport Layer Security

uiD Unique ldentifier

VR Value Representation
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1.5. IMPORTANT CONSIDERATIONS FOR THE READER

This Conformance Statement by itself does not guarantee successful interoperability.

Interoperability refers to the ability of application functions, distributed over two or more systems, to work
successfully together. The integration of medical devices into a networked environment may require
application functions that are not specified within the scope of DICOM. Consequently, the information
provided by this Conformance Statement does not guarantee interoperability.

It is the user’s responsibility to analyze thoroughly the application requirements and the environment of
the applications.
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2. IMPLEMENTATION MODEL

2.1. APPLICATION DATA FLOW DIAGRAM
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and radiation
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extract Dose
from MPPS

Synapse
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Synapse Dose
Adapter

Synapse Dose
MPPS Adapter

c-echo

c-store
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n-set

DICOM Standard Interface
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2.2. FUNCTIONAL DEFINITION OF APPLICATION ENTITIES

The Application Entity of the Synapse Mover acts as an SCU for the query and retrieve SOP classes.

The Application Entity of the Synapse Dose Adapter Application Entity waits for another application to
connect at the presentation address configured for its Application Entity Title. When another application
connects, the STORAGE-SCP AE expects it to be a DICOM application.

The STORAGE-SCP AE will accept Associations with Presentation Contexts for SOP Classes of the
Verification, Storage, and Storage Commitment Service Classes.

DICOM Instances received in a Storage Request are filed on local (attached/mounted) file system(s). A
subset of attributes from received Instances is also stored in records local database.

The MPPS Adapter Application Entity waits for another application to connect at the presentation
address configured for its Application Entity Title. When another application connects, the MPPS
Adapter AE expects it to be a DICOM application.

The MPPS Adapter AE will accept Associations with Presentation Contexts for SOP Classes of the
Verification and Modality Performed Procedure Step Service Classes.

The MPPS Adapter stores the received MPPS instances in the local database for further
processing.

3. SYNAPSE DOSE ADAPTER APPLICATION ENTITY SPECIFICATION

The central and peripheral nodes must be able to reach the remote update system via the Internet using
the https protocol; peripheral nodes must be able to access the central node via https protocol; the
central and peripheral nodes must be able to be reached by PACS via DICOM protocol.

3.1. SOP CLASSES

SOP Class Name SOP Class UID

OphthalmicTomographylmageStorage

1.2.840.10008.5.1.4.1.1.77.1.5.4

ComprehensiveSRStorage

1.2.840.10008.5.1.4.1.1.88.33

EnhancedPETImageStorage

1.2.840.10008.5.1.4.1.1.130

StereometricRelationshipStorage

1.2.840.10008.5.1.4.1.1.77.1.5.3

MammographyCADSRStorage

1.2.840.10008.5.1.4.1.1.88.50

RTBrachyTreatmentRecordStorage

1.2.840.10008.5.1.4.1.1.481.6

EnhancedMRColorimageStorage

1.2.840.10008.5.1.4.1.1.4.3

XRayAngiographiclmageStorage

1.2.840.10008.5.1.4.1.1.12.1

KeyObjectSelectionDocumentStorage

1.2.840.10008.5.1.4.1.1.88.59

RTBeamsDeliverylnstructionStorage

1.2.840.10008.5.1.4.34.7

ColorPaletteStorage

1.2.840.10008.5.1.4.39.1

UltrasoundimageStorage

1.2.840.10008.5.1.4.1.1.6.1

RTStructureSetStorage

1.2.840.10008.5.1.4.1.1.481.3

RTlonPlanStorage

1.2.840.10008.5.1.4.1.1.481.8

GeneralECGWaveformStorage

1.2.840.10008.5.1.4.1.1.9.1.2

CTlmageStorage

1.2.840.10008.5.1.4.1.1.2

VisualAcuityMeasurementsStorage

1.2.840.10008.5.1.4.1.1.78.5

VLMicroscopiclmageStorage

1.2.840.10008.5.1.4.1.1.77.1.2

HangingProtocolStorage

1.2.840.10008.5.1.4.38.1

SurfaceSegmentationStorage

1.2.840.10008.5.1.4.1.1.66.5

DigitalMammographyXRaylmageStorageForPresentation

1.2.840.10008.5.1.4.1.1.1.2

StandaloneVOILUTStorageRetired

1.2.840.10008.5.1.4.1.1.11

UltrasoundMultiFramelmageStorageRetired 1.2.840.10008.5.1.4.1.1.3
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BasicVoiceAudioWaveformStorage

1.2.840.10008.5.1.4.1.1.9.4.1

GrayscaleSoftcopyPresentationStateStorageSOPClass

1.2.840.10008.5.1.4.1.1.11.1

ComprehensiveSRStorageTrialRetired

1.2.840.10008.5.1.4.1.1.88.4

SpectaclePrescriptionReportStorage

1.2.840.10008.5.1.4.1.1.78.6

ChestCADSRStorage

1.2.840.10008.5.1.4.1.1.88.65

VideoEndoscopiclmageStorage

1.2.840.10008.5.1.4.1.1.77.1.11

MRSpectroscopyStorage

1.2.840.10008.5.1.4.1.1.4.2

MultiFrameSingleBitSecondaryCapturelmageStorage

1.2.840.10008.5.1.4.1.1.7.1

XRayRadiationDoseSRStorage

1.2.840.10008.5.1.4.1.1.88.67

SubjectiveRefractionMeasurementsStorage

1.2.840.10008.5.1.4.1.1.78.4

RTConventionalMachineVerificationTrialRetired

1.2.840.10008.5.1.4.34.2

VLSlideCoordinatesMicroscopiclmageStorage

1.2.840.10008.5.1.4.1.1.77.1.3

HardcopyGrayscalelmageStorageSOPClassRetired

1.2.840.10008.5.1.1.29

EnhancedCTImageStorage

1.2.840.10008.5.1.4.1.1.2.1

DigitalMammographyXRaylmageStorageForProcessing

1.2.840.10008.5.1.4.1.1.1.2.1

SpatialRegistrationStorage

1.2.840.10008.5.1.4.1.1.66.1

VLMultiFramelmageStorageTrialRetired

1.2.840.10008.5.1.4.1.1.77.2

DigitalXRaylmageStorageForPresentation

1.2.840.10008.5.1.4.1.1.1.1

StorageServiceClass

1.2.840.10008.4.2

PseudoColorSoftcopyPresentationStateStorageSOPClass

1.2.840.10008.5.1.4.1.1.11.3

AmbulatoryECGWaveformStorage

1.2.840.10008.5.1.4.1.1.9.1.3

VideoMicroscopiclmageStorage

1.2.840.10008.5.1.4.1.1.77.1.2.1

RTlonMachineVerificationTrialRetired

1.2.840.10008.5.1.4.34.3

VideoPhotographiclmageStorage

1.2.840.10008.5.1.4.1.1.77.1.4.1

HardcopyColorimageStorageSOPClassRetired

1.2.840.10008.5.1.1.30

StandaloneModalityLUT StorageRetired

1.2.840.10008.5.1.4.1.1.10

StandalonePETCurveStorageRetired

1.2.840.10008.5.1.4.1.1.129

BasicStudyContentNotificationSOPClassRetired

1.2.840.10008.1.9

AutorefractionMeasurementsStorage

1.2.840.10008.5.1.4.1.1.78.2

ColorSoftcopyPresentationStateStorageSOPClass

1.2.840.10008.5.1.4.1.1.11.2

SecondaryCapturelmageStorage

1.2.840.10008.5.1.4.1.1.7

MRImageStorage

1.2.840.10008.5.1.4.1.1.4

RTImageStorage

1.2.840.10008.5.1.4.1.1.481.1

NuclearMedicinelmageStorageRetired

1.2.840.10008.5.1.4.1.1.5

OphthalmicPhotography16BitimageStorage

1.2.840.10008.5.1.4.1.1.77.1.5.2

RTPlanStorage

1.2.840.10008.5.1.4.1.1.481.5

RealWorldValueMappingStorage

1.2.840.10008.5.1.4.1.1.67

TwelveLeadECGWaveformStorage

1.2.840.10008.5.1.4.1.1.9.1.1

XRay3DAngiographiclmageStorage

1.2.840.10008.5.1.4.1.1.13.1.1

KeratometryMeasurementsStorage

1.2.840.10008.5.1.4.1.1.78.3

StandaloneCurveStorageRetired

1.2.840.10008.5.1.4.1.1.9

UltrasoundimageStorageRetired

1.2.840.10008.5.1.4.1.1.6

SpatialFiducialsStorage

1.2.840.10008.5.1.4.1.1.66.2

XRayAngiographicBiPlanelmageStorageRetired

1.2.840.10008.5.1.4.1.1.12.3

DeformableSpatialRegistrationStorage

1.2.840.10008.5.1.4.1.1.66.3

XRayRadiofluoroscopiclmageStorage

1.2.840.10008.5.1.4.1.1.12.2

StandaloneOverlayStorageRetired

1.2.840.10008.5.1.4.1.1.8

DigitalXRaylmageStorageForProcessing

1.2.840.10008.5.1.4.1.1.1.1.1

CardiacElectrophysiologyWaveformStorage

1.2.840.10008.5.1.4.1.1.9.3.1

VLImageStorageTrialRetired

1.2.840.10008.5.1.4.1.1.77.1

EncapsulatedCDAStorage

1.2.840.10008.5.1.4.1.1.104.2

RTDoseStorage

1.2.840.10008.5.1.4.1.1.481.2

StoredPrintStorageSOPClassRetired

1.2.840.10008.5.1.1.27

DigitalintraOralXRaylmageStorageForPresentation

1.2.840.10008.5.1.4.1.1.1.3

XAXRF GrayscaleSoftcopyPresentationStateStorage

1.2.840.10008.5.1.4.1.1.11.5

LensometryMeasurementsStorage

1.2.840.10008.5.1.4.1.1.78.1

PositronEmissionTomographylmageStorage

1.2.840.10008.5.1.4.1.1.128
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RespiratoryWaveformStorage 1.2.840.10008.5.1.4.1.1.9.6.1
EnhancedMRImageStorage 1.2.840.10008.5.1.4.1.1.41
ProcedurelLogStorage 1.2.840.10008.5.1.4.1.1.88.40
VLPhotographiclmageStorage 1.2.840.10008.5.1.4.1.1.77.1.4
AudioSRStorageTrialRetired 1.2.840.10008.5.1.4.1.1.88.2
ComputedRadiographylmageStorage 1.2.840.10008.5.1.4.1.11
OphthalmicPhotography8BitimageStorage 1.2.840.10008.5.1.4.1.1.77.1.5.1
BasicTextSRStorage 1.2.840.10008.5.1.4.1.1.88.11
GeneralAudioWaveformStorage 1.2.840.10008.5.1.4.1.1.9.4.2
HemodynamicWaveformStorage 1.2.840.10008.5.1.4.1.1.9.2.1
NuclearMedicinelmageStorage 1.2.840.10008.5.1.4.1.1.20
WaveformStorageTrialRetired 1.2.840.10008.5.1.4.1.1.9.1
SegmentationStorage 1.2.840.10008.5.1.4.1.1.66.4
RTBeamsTreatmentRecordStorage 1.2.840.10008.5.1.4.1.1.481.4
BreastTomosynthesislmageStorage 1.2.840.10008.5.1.4.1.1.13.1.3
EnhancedXAlmageStorage 1.2.840.10008.5.1.4.1.1.12.1.1
VLEndoscopiclmageStorage 1.2.840.10008.5.1.4.1.1.77.1.1
BasicStructuredDisplayStorage 1.2.840.10008.5.1.4.1.1.131
VerificationSOPClass 1.2.840.10008.1.1
MultiFrameTrueColorSecondaryCapturelmageStorage 1.2.840.10008.5.1.4.1.1.7.4
XRay3DCraniofaciallmageStorage 1.2.840.10008.5.1.4.1.1.13.1.2
EncapsulatedPDFStorage 1.2.840.10008.5.1.4.1.1.104.1
MultiFrameGrayscaleWordSecondaryCapturelmageStorage | 1.2.840.10008.5.1.4.1.1.7.3
DigitalintraOralXRaylmageStorageForProcessing 1.2.840.10008.5.1.4.1.1.1.3.1
RTlonBeamsTreatmentRecordStorage 1.2.840.10008.5.1.4.1.1.481.9
EnhancedUSVolumeStorage 1.2.840.10008.5.1.4.1.1.6.2
TextSRStorageTrialRetired 1.2.840.10008.5.1.4.1.1.88.1
RawDataStorage 1.2.840.10008.5.1.4.1.1.66
ColonCADSRStorage 1.2.840.10008.5.1.4.1.1.88.69
UltrasoundMultiFramelmageStorage 1.2.840.10008.5.1.4.1.1.3.1
MacularGridThicknessAndVolumeReportStorage 1.2.840.10008.5.1.4.1.1.79.1
ArterialPulseWaveformStorage 1.2.840.10008.5.1.4.1.1.9.5.1
EnhancedXRFImageStorage 1.2.840.10008.5.1.4.1.1.12.2.1
RTTreatmentSummaryRecordStorage 1.2.840.10008.5.1.4.1.1.481.7
DetailSRStorageTrialRetired 1.2.840.10008.5.1.4.1.1.88.3
MultiFrameGrayscaleByteSecondaryCapturelmageStorage | 1.2.840.10008.5.1.4.1.1.7.2
BlendingSoftcopyPresentationStateStorageSOPClass 1.2.840.10008.5.1.4.1.1.11.4
EnhancedSRStorage 1.2.840.10008.5.1.4.1.1.88.22

3.2. ASSOCIATION ESTABLISHMENT POLICIES

3.21. GENERAL

The Synapse Dose Adapter AE can both accept and propose Association Requests. The Synapse Dose
Adapter AE will accept Association Requests for the Verification, Storage, and Storage Commitment
Push Model Services. It will propose Associations only for the Storage Commitment Push Model Service.
The DICOM standard application context name for DICOM 3.0 is always accepted and proposed:

| Application Context Name | 1.2.840.10008.3.1.1.1 |

3.2.2.  NUMBER OF ASSOCIATIONS

The Synapse Dose Adapter AE can support multiple simultaneous Associations requested by peer AEs.
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3.2.3. ASYNCHRONOUS NATURE

The Synapse Dose Adapter AE does not support asynchronous communication. Multiple outstanding
transactions are not supported. It allows up to one invoked and one performed operation on an
Association (it is synchronous). Asynchronous mode of operation is not supported.

3.24. IMPLEMENTATION IDENTIFYING INFORMATION

The implementation information for this Application Entity is:

Implementation Class UID 1.2.40.0.13.1.1
Implementation Version name Dcm4che-3.3.7

3.3. ASSOCIATION INITIATION POLICY

3.3.1.  ACTIVITY — SEND STORAGE COMMITMENT NOTIFICATION OVER NEW ASSOCIATION
An Association Request is sent to the peer AE that sent the Storage Commitment Push Model request
and upon successful negotiation of the required Presentation Context the outstanding N-EVENT-
REPORT is sent.

3.3.1.1 PROPOSED PRESENTATION CONTEXTS

Synapse Dose Adapter will propose Presentation Contexts as shown in the following table:

Abstract Syntax Transfer Syntax Role Ext. Neg.
Name uiD Name List | UID List
Verification 1.2.840.10008.1.1 Implicit 1.2.840.10008.1.2 | SCU None
VR Little
Endian
Storage 1.2.840.10008.1.20.1.1 | Implicit 1.2.840.10008.1.2 | SCP None
Commitment | .1 VR Little
Push Model Endian
Implicit 1.2.840.10008.1.2
VR Little N
Endian
3.31.2 SOP SPECIFIC CONFORMANCE FOR VERIFICATION SOP CLASS

Standard conformance is provided to the DICOM Verification Service Class as an SCU. The Verification
Service as an SCU is actually only supported as a diagnostic service tool for network communication
issues. It can be used to test whether Associations can actually be opened with a peer AE that is issuing
Storage Commitment Push Model requests (i.e. to test whether the indicated TCP/IP port and AE Title
for sending NEVENT-REPORT Requests to the peer AE are truly functional).

3.3.1.3 SPECIFIC CONFORMANCE FOR STORAGE COMMITMENT SOP CLASSES

The associated Activity with the Storage Commitment Push Model service is the communication by the
Synapse Dose Adapter AE to peer AEs that it has committed to permanently store Composite SOP
Instances that have been sent to it.

It thus allows peer AEs to determine whether the Synapse Dose Adapter has taken responsibility for the
archiving of specific SOP Instances so that they can be flushed from the peer AE system.
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3.4. ASSOCIATION ACCEPTANCE POLICY

3.4.1. ACTIVITY — RECEIVE IMAGES AND STORAGE COMMITMENT REQUESTS

A remote peer DICOM Application Entity, acting as a Storage SCU, establishes an association with
Synapse Dose Adapter that accepts these Associations for the purpose of receiving supported SOP
Class Instances and Storage Commitment requests.

In the default configuration any Calling and Called AET will be accepted. But if the Called AET does not
correspond to the actual Storage Server AET, only a Presentation Context for the Verification SOP Class
will be accepted and the SCU can only verify the DICOM Association but cannot invoke any other related
DICOM service.

The Storage Server AE may reject Association attempts as shown in the table below. The Result, Source
and Reason / Diag columns represent the values returned in the corresponding fields of an
ASSOCIATE-RJ PDU

Association Rejection Reasons:

Result Source Reason Description
2 - rejected provider 2 - locallimit The (configurable) maximum number of simultaneous
transient exceeded associations has been reached. An association request with
the same parameters may succeed at a later time.
1 - rejected user 2 - application The Association request contained an unsupported
permanent context Application Context Name. An association request with the
name same parameters will NOT succeed at a later time.
not supported
1 - rejected user 3 —calling The Association request contained an unrecognized Calling
permanent AE title not AE Title. An association request with the same parameters
recognized will NOT succeed at a later time unless configuration
changes are made.

3.4.1.1 ACCEPTED PRESENTATION CONTEXTS

Abstract Syntax Transfer Syntax Role Ext.

Name uiD Name UID List Neg.
List

Verification 1.2.840.10008.1.1 Implicit | 1.2.840.10008.1.2 SCU None
VR Little
Endian

Storage 1.2.840.10008.1.20.1.1.1 Transfer Syntaxes for Non- SCP None

Commitment Push Image Storage Services

Model

Hardcopy 1.2.840.10008.5.1.1.29 Transfer Syntaxes for Image SCP None

Grayscale Image Storage Service

Storage SOP Class

Hardcopy Color 1.2.840.10008.5.1.1.30 Transfer Syntaxes for Image SCP None

Image Storage SOP Storage Service

Class
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Computed 1.2.840.10008.5.1.4.1.1.1 Transfer Syntaxes for Image SCP None

Radiography Image Storage Service

Storage

Digital X-Ray Image | 1.2.840.10008.5.1.4.1.1.1.1 Transfer Syntaxes for Image SCP None

Storage — For Storage Service

Presentation

Digital X-Ray Image | 1.2.840.10008.5.1.4.1.1.1.1.1 Transfer Syntaxes for Image SCP None

Storage - For Storage Service

Processing

Digital 1.2.840.10008.5.1.4.1.1.1.2 Transfer Syntaxes for Image SCP None

Mammography X- Storage Service

Ray Image

Storage - For

Presentation

Digital 1.2.840.10008.5.1.4.1.1.1.2.1 Transfer Syntaxes for Image SCP None

Mammography X- Storage Service

Ray Image

Storage - For

Processing

Digital Intra-oral X- | 1.2.840.10008.5.1.4.1.1.1.3 Transfer Syntaxes for Image SCP None

Ray Image Storage Storage Service

- For Presentation

Digital Intra-oral X- | 1.2.840.10008.5.1.4.1.1.1.3.1 Transfer Syntaxes for Image SCP None

Ray Image Storage Storage Service

- For Processing

CT Image Storage 1.2.840.10008.5.1.4.1.1.2 Transfer Syntaxes for Image SCP None
Storage Service

Ultrasound Multi- 1.2.840.10008.5.1.4.1.1.3.1 Transfer Syntaxes for Image SCP None

frame Image Storage Service

Storage

MR Image Storage | 1.2.840.10008.5.1.4.1.1.4 Transfer Syntaxes for Image SCP None
Storage Service

Enhanced MR 1.2.840.10008.5.1.4.1.1.4.1 Transfer Syntaxes for Image SCP None

Image Storage Storage Service

Ultrasound Image 1.2.840.10008.5.1.4.1.1.6.1 Transfer Syntaxes for Image SCP None

Storage Storage Service

Secondary Capture | 1.2.840.10008.5.1.4.1.1.7 Transfer Syntaxes for Image SCP None

Image Storage Storage Service
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X-Ray 1.2.840.10008.5.1.4.1.1.12.1 Transfer Syntaxes for Image SCP None

Angiographic Storage Service

Image Storage

X-Ray 1.2.840.10008.5.1.4.1.1.12.2 Transfer Syntaxes for Image SCP None

Radiofluoroscopic Storage Service

Image

Storage

Nuclear Medicine 1.2.840.10008.5.1.4.1.1.20 Transfer Syntaxes for Image SCP None

Image Storage Storage Service

Raw Data Storage 1.2.840.10008.5.1.4.1.1.66 Transfer Syntaxes for Image SCP None
Storage Service

VL Endoscopic 1.2.840.10008.5.1.4.1.1.77.1.1 Transfer Syntaxes for Image SCP None

Image Storage Storage Service

VL Microscopic 1.2.840.10008.5.1.4.1.1.77.1.2 Transfer Syntaxes for Image SCP None

Image Storage Storage Service

VL Slide- 1.2.840.10008.5.1.4.1.1.77.1.3 Transfer Syntaxes for Image SCP None

Coordinates Storage Service

Microscopic

Image Storage

Positron Emission 1.2.840.10008.5.1.4.1.1.128 Transfer Syntaxes for Image SCP None

Tomography Storage Service

Image

Storage

RT Image Storage 1.2.840.10008.5.1.4.1.1.481.1 Transfer Syntaxes for Image SCP None
Storage Service

Grayscale Softcopy | 1.2.840.10008.5.1.4.1.1.11.1 Transfer Syntaxes for Image SCP None

Presentation Storage Service

State Storage SOP

Class

Basic Text SR 1.2.840.10008.5.1.4.1.1.88.11 Transfer Syntaxes for Image SCP None
Storage Service

Enhanced SR 1.2.840.10008.5.1.4.1.1.88.22 Transfer Syntaxes for Image SCP None
Storage Service

Comprehensive SR | 1.2.840.10008.5.1.4.1.1.88.33 Transfer Syntaxes for Image SCP None
Storage Service

Key Object 1.2.840.10008.5.1.4.1.1.88.59 Transfer Syntaxes for Image SCP None

Selection Storage Service

Document
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Accepted Transfer Syntaxes for Non-Image Storage Services

Name uiD

Implicit VR Little Endian 1.2.840.10008.1.2
Explicit VR Little Endia 1.2.840.10008.1.2.1
JPEG Baselin 1.2.840.10008.1.2.4.50
JPEG Extended 1.2.840.10008.1.2.4.51
JPEG Lossless, Non-Hierarchical 1.2.840.10008.1.2.4.57
JPEG Lossless, Non-Hierarchical, First-Order 1.2.840.10008.1.2.4.70
Prediction

JPEG-LS Lossless Image Compression

JPEG-LS Lossy (Near-Lossless) Image

JPEG 2000 Image Compression (Lossless Only)
JPEG 2000 Image Compression

1.2.840.10008.1.2.4.80
1.2.840.10008.1.2.4.81
1.2.840.10008.1.2.4.90
1.2.840.10008.1.2.4.91

3.4.1.2 SPECIFIC CONFORMANCE FOR VERIFICATION SOP CLASS
Synapse Dose Storage Server provides standard conformance to the DICOM Verification Service Class

as a SCP. The status code for the C-ECHO is described in the following table:

Service Status Further Meaning Error Code Behaviour
Success Success 0000 The C-ECHO request
is accepted
3.4.1.3 SPECIFIC CONFORMANCE FOR STORAGE SOP CLASSES

The associated Activity with the Storage service is the storage of medical DICOM data received over
the network on a designated storage repository. The Synapse Dose Adapter AE will return a failure
status if it is unable to store the received instance(s).

The Synapse Dose Adapter AE does not have any dependencies on the number of Associations used
to send images to it. Images belonging to more than one Study or Series can be sent over a single or
multiple Associations. Images belonging to a single Study or Series can also be sent over different
Associations. There is no limit on either the number of SOP Instances or the maximum amount of total
SOP Instance data that can be transferred over a single Association.

The Synapse Dose Adapter AE is configured to retain the original DICOM data in DICOM Part 10
compliant file format. The Synapse Dose Adapter AE is Level 2 (Full) conformant as a Storage SCP. In
addition, all Private and SOP Class Extended Elements are maintained in the DICOM format files. In

addition to saving all Elements in files, a subset of the Elements is stored in the Synapse Dose Server

database.
3414 STORAGE SERVER AE C-STORE RESPONSE

Service Status Further Meaning Error Code Behaviour

Success Success 0000 The Composite SOP
Instance was successfully
received, verified, and
stored in the system
repository.

Error Processing Failure 0110 This status is returned
due to internal errors such
as a processing failure
response from the internal
database or a filesystem
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operation. The
appropriate

Status will be sent in the
C-STORE Response.
Error indication
message is output to the
Service Log.

Warning

Coercion of Data
Elements

BO0O

This status is returned if
one or more Attribute
values were coerced/
modified on reception.
Image transmission is
considered successful.
The

appropriate SUCCESS
Status will be sent in the
C-STORE Response.
Warning indication
message is output to the
Service Log.

Warning

Data Set does not
match SOP class

BOO7

This status is returned if
the C-STORE Request
specifies Attributes that
are not specific as part of
the Storage SOP class.
Image transmission is
considered successful.
The appropriate
SUCCESS Status will be
sentin

the C-STORE Response.
Warning indication
message is output to the
Service Log.

4. SYNAPSE MOVER APPLICATION ENTITY SPECIFICATION

4.1. SOP CLASSES

SOP Classes as SCU

SOP Class Name

SOP Class UID

Study Root Q/R - Information Model - FIND

1.2.840.10008.5.1.4.1.2.2.1

Study Root Q/R - Information Model - MOVE

1.2.840.10008.5.1.4.1.2.2.2

4.2. ASSOCIATION POLICIES

4.2.1. ACTIVITY — RECEIVE IMAGES AND STORAGE COMMITMENT REQUESTS

The Synapse Mover AE can only propose Association Requests. The Synapse Dose Adapter AE will

accept Association Requests for the Verification, Storage, and Storage Commitment Push Model

Services. It will propose Associations for the Study root Q/R Information Model Service. The DICOM

standard application context name for DICOM 3.0 is always accepted and proposed:
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| Application Context Name | 1.2.840.10008.3.1.1.1

4.2.2. NUMBER OF ASSOCIATIONS
The Synapse Mover AE can initiate multiple simultaneous associations at a time in order to retrieve all
the study information matching the search criteria.

For the Retrieve request only one association is initiated per destination.

4221 ASYNCHRONOUS NATURE
The Synapse Dose Adapter AE does not support asynchronous communication. Multiple outstanding
transactions are not supported. It allows up to one invoked and one performed operation on an

Association (it is synchronous). Asynchronous mode of operation is not supported.

4222 IMPLEMENTATION IDENTIFYING INFORMATION

The implementation information for this Application Entity is:

Implementation Class UID 1.2.40.0.13.1.1
Implementation Version name Dcm4che-3.3.7

4.3. ASSOCIATION INITIATION POLICIES

4.3.1. ACTIVITY — SEARCH FOR STUDY (C-FIND)
Synapse Mover has a scheduler functionality that will automatically fill out a C-FIND query in order to
obtain all the Study of a calculated Date/Time range. The user can submit more scheduled Task in order

to Query different remote AE.

4.3.1.1 PROPOSED PRESENTATION CONTEXTS
Abstract Syntax Transfer Syntax Role | Ext.
Name uIiD Name UID List Neg.
List
Study Root 1.2.840.10008.5.1.4.1.2.2.1 Implicit 1.2.840.10008.1.2 SCU | None
Query/Retrieve VR Little
Model - FIND Endian
4.3.1.2 SOP SPECIFIC CONFORMANCE
Supported keys for Study Root Query/Retrieve
Level Description Tag Type Matching
Study Study Date (0008,0020) R Range
Study Study (0008,0030) 0] Range

The Synapse Mover AE C-FIND SCU interprets following status codes:

Service Status Further Meaning Error Code Behavior

Success Success 0000 Matching is complete.
No final identifier is
supplied
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Refused

Out of Resources

A700

System reached the
limit in disk space or
memory usage.

Error message is
output to as an alert to
the User Interface,

and to the Service Log.

Failed

Identifier does
not match
SOP Class

A900

The C-FIND query
identifier contains
invalid Elements or
values, or is missing
mandatory Elements
or values for the
specified SOP Class.
Error message is
output to the Service
Log.

Unable to
process

CO001

The C-FIND query
identifier is valid for the
specified SOP

Class but cannot be
used to query the
database. For
example, this can
occur if a Patient Level
query is issued

but the identifier has
only empty values for
both the Patient

ID and the Patient
Name.

Error message is
output to the Service
Log.

Cancel

Matching
terminated
due to Cancel
Request

FEOO

The C-FIND SCU sent
a Cancel Request.
This has been
acknowledged and the
search for matches
has been halted.

Pending

Matches are
continuing
and current
match is
supplied.

FFOO

Indicates that the
search for further
matches is continuing.
This is returned when
each successful match
is returned

and when further
matches are
forthcoming. This
status

code is returned if all
Optional keys in the
query identifier

are actually supported.

Matches are
continuing but
one or more
Optional Keys
were not

FFO1

Indicates that the
search for further
matches is continuing.
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supported. This is returned when
each successful match
is returned

and when further
matches are
forthcoming. This
status

code is returned if
there are Optional
keys in the query
identifier that are not
supported.

4.3.2. ACTIVITY — RETRIEVE IMAGES (C-MOVE)
When the Synapse Mover AE C-FIND activity is finished a retrieval C-MOVE request will be issued in

order to initiate the import of all the selected Study to the configured Destination AE.

4.3.2.1 PROPOSED PRESENTATION CONTEXTS
Abstract Syntax Transfer Syntax Role | Ext.
Name uiD Name UID List Neg.
List

Query/Retrieve 1.2.840.10008.5.1.4.1.2.2.2 Implicit 1.2.840.10008.1.2 SCU | None

Model Study VR Little

Root - MOVE Endian

4322 SPECIFIC CONFORMANCE
Service Status Further Meaning Error Code Behavior
Success Success 0000 All the Composite SOP Instances have been
successfully
sent to the C-MOVE Destination AE.

Refused Out of Resources A701 Number of matches cannot be determined
Unable to calculate due to system failure. Returned if the
number of matches server’s database is not functioning so the

search for matches to the C-MOVE
Request cannot be found.
Error message is output as an alert on the
User Interface, and to the Service Log.
Out of Resources A702 C-STORE sub-operations cannot be
Unable to perform performed due to failure to access
suboperations Composite SOP Instances in archive, or
failure of a C-STORE Request. For
example, this Status will be returned if the
required SOP Instances are determined to
be off-line (i.e. the MO media has been
removed from the archive jukebox).
Error message is output as an alert on the
User Interface, and to the Service Log.
Move destination A801 The Destination Application Entity named in
unknown the C-MOVE Request is unknown to Query-
Retrieve SCP AE.
Error message is output to the Service Log.

Failed Identifier does not A900 The C-MOVE identifier contains invalid

match SOP Class Elements or values, or is missing
mandatory Elements or values for the
specified SOP Class or retrieval level.
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Error message is output to the Service Log.
Cancel Matching terminated FEOO The C-MOVE SCU sent a Cancel Request.
due to Cancel This has been acknowledged and the
Request export of Composite SOP Instances
to the C-MOVE Destination AE has been
halted.
Pending Suboperations are FFOO A Response with this Status Code is sent
continuing every time a Composite SOP Instance has
been successfully sent to the
C-MOVE Destination AE.

5. SYNAPSE DOSE MPPS ADAPTER APPLICATION ENTITY SPECIFICATION

5.1. SOP CLASSES

SOP Class Name SOP Class UID
VerificationSOPClass 1.2.840.10008.1.1
ModalityPerformedProcedureStepSOPClass 1.2.840.10008.3.1.2.3.3

5.2. ASSOCIATION ESTABLISHMENT POLICIES

5.21. GENERAL

Synapse Dose MPPS Adapter receives Modality Performed Procedure Step messages from modalities,
stores them in database and later extract dose related information. The operators allowed are MPPS N-
CREATE and N-SET. Only after the N-SET message with status COMPLETED is received, the message
attributes are stored in local database.

The DICOM standard application context name for DICOM 3.0 is always accepted and proposed:

| Application Context Name | 1.2.840.10008.3.1.1.1 |

5.2.2. NUMBER OF ASSOCIATIONS
The Synapse Dose MPPS Adapter AE can support multiple simultaneous Associations requested by

peer AEs.

5.2.3.  ASYNCHRONOUS NATURE

The Synapse Dose MPPS Adapter AE does not support asynchronous communication.

5.2.4. IMPLEMENTATION IDENTIFYING INFORMATION

The implementation information for this Application Entity is:

Implementation Class UID 1.2.40.0.13.1.1
Implementation Version name Dcmé4che-3.3.7
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5.3. ASSOCIATION INITIATION POLICIES

5.3.1.  ACTIVITY - MPPS N-CREATE

When an N-CREATE request is received, an initial validation is performed internally for the presence of
mandatory attributes in the message and for ensuring the absence of certain attributes as mentioned in
the DICOM standards. The message is saved to local file system.

Synapse Dose MPPS Adapter will behave as described in next table when constructing the N-CREATE

response command message.

Service Status Further Meaning Error Code Behavior
Success Processing Success 0000 N-CREATE message
received successfully
Failure Processing failure 0110 N-CREATE message
transfer failed
Failure Duplicate SOP | 0111 N-CREATE message
Instance transfer failed

5.3.2.  ACTIVITY - MPPS N-SET
When an N-SET request is received and the Performed Procedure Step Status has status COMPLETED,
the message is stored to the Synapse Dose database and later processed for extracting dose
information.

Synapse Dose MPPS Adapter will behave as described in next table when constructing the N-SET
response command message.

Service Status Further Meaning Error Code Behavior

Success Processing Success 0000 N- SET message

received successfully

Failure Processing failure 0110 N-SET message
transfer failed
Failure No Such SOP Instance | 0112 N-SET message

transfer failed

6. COMMUNICATION PROFILE

6.1. SUPPORTED COMMUNICATION STACKS

DICOM Upper Layer over TCP/IP is supported.
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6.2. TCP/IP STACK

The Synapse Dose Adapter and Mover AE inherits their TCP/IP stack from the installed Java Runtime

Environment.

6.2.1. PHYSICAL NETWORK INTERFACE
The Synapse Dose Adapter and Mover AE are indifferent to the physical medium over which TCP/IP

executes; it inherits this from the Java Runtime Environment.

7. ACQUISITION OF RADIATION EXPOSURE

The Synapse Dose Adapter implements DICOM services to acquire the Radiation Exposure. Radiation
dose information can be acquired from DICOM Radiation Dose SR instances, DICOM MPPS messages

or DICOM image headers.

7.1. DICOM IMAGE HEADER

7.1.1.  X-RAY /RF INSTANCES

When DICOM X-Ray instances are acquired from the Synapse Dose Adapter, a list of attributes is stored
in records local database. Here below a list of the attributes which are stored and mapped to local

information entities in the database is represented.

Attribute Name Tag Mandatory
Patient ID 0010,0020 YES
Patient's Birth Date 0010,0030 NO
Patient's Sex 0010,0040 NO
Patient's Name 0010,0010 NO
Accession Number 0008,0050 NO
Study Date 0008,0020 YES
Study Time 0008,0030 YES
Study Description 0008,1030 YES
Study Instance UID 0020,000D YES
Patient Weight 0010,1030 NO
Patient Size 0010,1020 NO
SOP Instance UID 0008,0018 YES
Instance Number 0020,0013 NO
Series Number 0020,0011 NO
Series Instance UID 0020,000E NO
Series Description 0008,103E NO
Body Part Examined 0018,0015 NO
Protocol Name 0018,1030 NO
Acquisition Date 0008,0022 NO
Acquisition Time 0008,0032 NO
Anatomic Region Sequence 0008,2218 NO
Irradiation Event UID 0008,3010 NO
Image Laterality 0020,0062 NO
Image Comments 0020,4000 NO
Number of Frames 0028,0008 NO
Manufacturer 0008,0070 NO
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Institution Name 0008,0080 NO
Station Name 0008,1010 NO
Manufacturer's Model Name 0008,1090 NO
Device Serial Number 0018,1000 NO
Software Versions 0018,1020 NO
Exposure Control Mode 0018,7060 NO
KVP 0018,0060 NO
Exposure Time 0018,1150 NO
X-Ray Tube Current 0018,1151 NO
Exposure 0018,1152 NO
Distance Source to Detector 0018,1110 NO
Distance Source to Patient 0018,1111 NO
Image and Fluoroscopy Area Dose Product 0018,115E NO
Body Part Thickness 0018,11A0 NO
Filter Material 0018,7050 NO
Filter Thickness Minimum 0018,7052 NO
Filter Thickness Maximum 0018,7054 NO
Exposed Area 0040,0303 NO
Positioner Primary Angle 0018,1510 NO
Positioner Secondary Angle 0018,1511 NO
Patient Position 0018,5100 NO
View Position 0018,5101 NO
Field of View Shape 0018,1147 NO
Field of View Dimension(s) 0018,1149 NO
Grid 0018,1166 NO
Acquisition Device Processing Description 0018,1400 NO

7.1.2. DIGITAL MAMMOGRAPHY X-RAY INSTANCES

When Digital Mammography X-Ray instances are acquired from the Synapse Dose Adapter, a list of
attributes is stored in records local database. Here below a list of the attributes which are stored and
mapped to local information entities in the database is represented.

Attribute Name Tag Mandatory
Patient ID 0010,0020 YES
Patient's Birth Date 0010,0030 NO
Patient's Sex 0010,0040 NO
Patient's Name 0010,0010 NO
Accession Number 0008,0050 NO
Study Date 0008,0020 YES
Study Time 0008,0030 YES
Study Description 0008,1030 YES
Study Instance UID 0020,000D YES
Patient Weight 0010,1030 NO
Patient Size 0010,1020 NO
SOP Instance UID 0008,0018 YES
Instance Number 0020,0013 NO
Series Number 0020,0011 NO
Series Instance UID 0020,000E NO
Series Description 0008,103E NO
Body Part Examined 0018,0015 NO
Protocol Name 0018,1030 NO
Acquisition Date 0008,0022 NO
Acquisition Time 0008,0032 NO
Anatomic Region Sequence 0008,2218 NO
Irradiation Event UID 0008,3010 NO
Image Laterality 0020,0062 NO
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Image Comments 0020,4000 NO
Number of Frames 0028,0008 NO
Manufacturer 0008,0070 NO
Institution Name 0008,0080 NO
Station Name 0008,1010 NO
Manufacturer's Model Name 0008,1090 NO
Device Serial Number 0018,1000 NO
Software Versions 0018,1020 NO
Exposure Control Mode 0018,7060 NO
KVP 0018,0060 NO
Exposure Time 0018,1150 NO
X-Ray Tube Current 0018,1151 NO
Exposure 0018,1152 NO
Distance Source to Detector 0018,1110 NO
Distance Source to Patient 0018,1111 NO
Body Part Thickness 0018,11A0 NO
Filter Material 0018,7050 NO
Filter Thickness Minimum 0018,7052 NO
Filter Thickness Maximum 0018,7054 NO
Positioner Primary Angle 0018,1510 NO
Positioner Secondary Angle 0018,1511 NO
View Position 0018,5101 NO
Field of View Shape 0018,1147 NO
Field of View Dimension(s) 0018,1149 NO
Grid 0018,1166 NO
Organ Dose 0040,0316 NO
Anode Target Material 0018,1191 NO
Half Value Layer 0040,0314 NO
Entrance Dose in mGy 0040,8302 NO
Compression Force 0018,11A2 NO
Focal Spot(s) 0018,1190 NO

7.1.3.

DIGITAL ANGIOGRAPHY INSTANCES

When Digital Angiography instances are acquired from the Synapse Dose Adapter, a list of attributes
is stored in records local database. Here below a list of the attributes which are stored and mapped to
local information entities in the database is represented.

Attribute Name Tag Mandatory
Patient ID 0010,0020 YES
Patient's Birth Date 0010,0030 NO
Patient's Sex 0010,0040 NO
Patient's Name 0010,0010 NO
Accession Number 0008,0050 NO
Study Date 0008,0020 YES
Study Time 0008,0030 YES
Study Description 0008,1030 YES
Study Instance UID 0020,000D YES
Patient Weight 0010,1030 NO
Patient Size 0010,1020 NO
SOP Instance UID 0008,0018 YES
Instance Number 0020,0013 NO
Series Number 0020,0011 NO
Series Instance UID 0020,000E NO
Series Description 0008,103E NO
Body Part Examined 0018,0015 NO
Protocol Name 0018,1030 NO
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Acquisition Date 0008,0022 NO
Acquisition Time 0008,0032 NO
Anatomic Region Sequence 0008,2218 NO
Irradiation Event UID 0008,3010 NO
Image Laterality 0020,0062 NO
Image Comments 0020,4000 NO
Number of Frames 0028,0008 NO
Manufacturer 0008,0070 NO
Institution Name 0008,0080 NO
Station Name 0008,1010 NO
Manufacturer's Model Name 0008,1090 NO
Device Serial Number 0018,1000 NO
Software Versions 0018,1020 NO
KVP 0018,0060 NO
Exposure Time 0018,1150 NO
X-Ray Tube Current 0018,1151 NO
Exposure 0018,1152 NO
Distance Source to Detector 0018,1110 NO
Distance Source to Patient 0018,1111 NO
Image and Fluoroscopy Area Dose Product 0018,115E NO
Body Part Thickness 0018,11A0 NO
Filter Material 0018,7050 NO
Filter Thickness Minimum 0018,7052 NO
Filter Thickness Maximum 0018,7054 NO
Exposed Area 0040,0303 NO
Positioner Primary Angle 0018,1510 NO
Positioner Secondary Angle 0018,1511 NO
Patient Position 0018,5100 NO
View Position 0018,5101 NO
Field of View Shape 0018,1147 NO
Field of View Dimension(s) 0018,1149 NO
Grid 0018,1166 NO
Acquisition Device Processing Description 0018,1400 NO
Intensifier Size 0018,1162 NO
Estimated Radiographic Magnification Factor 0018,1114 NO
Focal Spot(s) 0018,1190 NO
Cine Rate 0018,0040 NO
Frame Time 0018,1063 NO
Average Pulse Width 0018,1154 NO
Collimator Left Vertical Edge 0018,1702 NO
Collimator Right Vertical Edge 0018,1704 NO
Collimator Upper Horizontal Edge 0018,1706 NO
Collimator Lower Horizontal Edge 0018,1708 NO
Patient Orientation 0020,0020 NO
Radiation Mode 0018,115A NO

7.14. COMPUTED TOMOGRAPHY INSTANCES

When Computed Tomography instances are acquired from the Synapse Dose Adapter, a list of
attributes is stored in records local database. Here below a list of the attributes which are stored and
mapped to local information entities in the database is represented.

Attribute Name Tag Mandatory
Patient ID 0010,0020 YES
Patient's Birth Date 0010,0030 NO
Patient's Sex 0010,0040 NO
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Patient's Name 0010,0010 NO
Accession Number 0008,0050 NO
Study Date 0008,0020 YES
Study Time 0008,0030 YES
Study Description 0008,1030 YES
Study Instance UID 0020,000D YES
Patient Weight 0010,1030 NO
Patient Size 0010,1020 NO
SOP Instance UID 0008,0018 YES
Instance Number 0020,0013 NO
Media Storage SOP Class UID 0002,0002 NO
Series Number 0020,0011 NO
Series Instance UID 0020,000E NO
Series Description 0008,103E NO
Body Part Examined 0018,0015 NO
Acquisition Date 0008,0022 NO
Acquisition Time 0008,0032 NO
Irradiation Event UID 0008,3010 NO
Image Comments 0020,4000 NO
Number of Frames 0028,0008 NO
Water Equivalent Diameter 0018,1271 NO
Pixel Spacing 0028,0030 NO
Image Position 0020,0032 NO
Software Versions 0018,1020 NO
X-Ray Tube Current 0018,1151 NO
Raws Attribute 0028,0010 NO

7.1.5. SECONDARY CAPTURE INSTANCES

When DICOM X-Ray instances are acquired from the Synapse Dose Adapter, a list of attributes is
stored in records local database. Here below a list of the attributes which are stored and mapped to

local information entities in the database is represented.

Attribute Name Tag Mandatory
Patient ID 0010,0020 YES
Patient's Birth Date 0010,0030 NO
Patient's Sex 0010,0040 NO
Patient's Name 0010,0010 NO
Accession Number 0008,0050 NO
Study Date 0008,0020 YES
Study Time 0008,0030 YES
Study Description 0008,1030 YES
Study Instance UID 0020,000D YES
Patient Weight 0010,1030 NO
Patient Size 0010,1020 NO
SOP Instance UID 0008,0018 YES
Instance Number 0020,0013 NO
Series Number 0020,0011 NO
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Series Instance UID 0020,000E NO
Series Description 0008,103E NO
Acquisition Date 0008,0022 NO
Acquisition Time 0008,0032 NO
Image Comments 0020,4000 NO
Number of Frames 0028,0008 NO
Manufacturer 0008,0070 NO
Institution Name 0008,0080 NO
Station Name 0008,1010 NO
Manufacturer's Model Name 0008,1090 NO
Device Serial Number 0018,1000 NO
Software Versions 0018,1020 NO
Exposure Dose Sequence 0040,030E NO
Exposure Dose Sequence
Attribute Name Tag Mandatory
Body Part Examined 0018,0015 NO
Protocol Name 0018,1030 NO
Exposure Time 0018,1150 NO
Exposure in yAs 0018,1153 NO
Single Collimation Width 0018,9306 NO
Total Collimation Width 0018,9307 NO
KVP 0018,0060 NO
Spiral Pitch Factor 0018,9311 NO
Acquisition Type 0018,9302 NO
CTDlvol 0018,9345 NO
CTDI Phantom Type Code Sequence 0018,9346 NO
DLP 00E10021 NO

7.2. CT/ X-RAY RADIATION DOSE SR INSTANCES

When DICOM Radiation Dose SR instances are acquired from the Synapse Dose Adapter, a list of
attributes is stored in records local database. Here below the modules acquired from the SyncoDose
Adapter present the attributes which are stored and mapped to local information entities in the
database.

CT Radiation Dose

NL Rel with Parent VT Concept Name

CONTAINER 113701, X-Ray Radiation Dose Report
> HAS CONCEPT MOD | CODE 121058, Procedure reported
> HAS OBS CONTEXT DATETIME 113809, Start of X-ray Irradiation
> HAS OBS CONTEXT DATETIME 113810, End of X-ray Irradiation
> CONTAINS INCLUDE 113811, CT Accumulated Dose Data
> CONTAINS INCLUDE 113819, CT Irradiation Event Data

CT ACCUMULATED DOSE DATA

NL Rel with Parent VT Concept Name
CONTAINER 113811, CT Accumulated Dose Data
> CONTAINS NUM 113812, Total Number of Irradiation Events

CT IRRADIATION EVENT DATA
NL [ Rel with Parent | vT | Concept Name
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CONTAINER 113819, CT Acquisition
> CONTAINS TEXT 125203, Acquisition Protocol
> CONTAINS CODE 123014, Target Region
> CODE CODE 113820, CT Acquisition Type
> CONTAINS UIDREF 113769, Irradiation Event UID
> CONTAINS CONTAINER 113822, CT Acquisition Parameters
>> CONTAINS NUM 113824, Exposure Time
>> CONTAINS NUM 113825, Scanning Length
>> CONTAINS NUM 113826, Nominal Single Collimation Width
>> CONTAINS NUM 113827, Nominal Total Collimation Width
>> CONTAINS NUM 113828, Pitch Factor
>> CONTAINS NUM 113823, Number of X-ray Sources
>> CONTAINS NUM 113897, Top Z Location of Scanning Length
>> CONTAINS NUM 113898, Bottom Z Location of Scanning
Length
>> CONTAINS CONTAINER 113831, CT X-ray Source Parameters
>>> CONTAINS TEXT 113832, Identification Number of the X-ray
Source
>>> CONTAINS NUM 113733, KVP
>>> CONTAINS NUM 113833, Maximum X-ray Tube Current
>>> CONTAINS NUM 113734, Mean X-ray Tube Current
>>> CONTAINS NUM 113834, Exposure Time per Rotation
> CONTAINS CONTAINER 113829, CT Dose
>> CONTAINS NUM 113830, Mean CTDIvol
>> CONTAINS CODE 113835, CTDIw Phantom Type
>> CONTAINS NUM 113836, CTDlfreeair Calculation Factor
>> CONTAINS NUM 113837, Mean CTDlfreeair
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>> CONTAINS NUM 113838, DLP
>> CONTAINS NUM 113839, Effective Dose
X-Ray Radiation Dose
NL Rel with Parent VT Concept Name
CONTAINER 113701, X-Ray Radiation Dose Report
> HAS CONCEPT MOD | CODE 121058, Procedure reported
> CONTAINS INCLUDE 113702, Accumulated XRay Dose Data
> CONTAINS INCLUDE 113706, Irradiation Event XRay Data
ACCUMULATED X-RAY DOSE
NL Rel with Parent VT Concept Name
CONTAINER 113702, Accumulated XRay Dose Data
> HAS CONCEPT MOD | CODE 113764, Acquisition Plane
> CONTAINS TEXT 113780, Reference Point Definition
> CONTAINS NUM 113722, Dose Area Product Total
> CONTAINS NUM 113725, Dose (RP) Total
> CONTAINS NUM 113726, Fluoro Dose Area Product Total
> CONTAINS NUM 113728, Fluoro Dose (RP) Total
> CONTAINS NUM 113730, Total Fluoro Time
> CONTAINS NUM 113727, Acquisition Dose Area Product Total
> CONTAINS NUM 113729, Acquisition Dose (RP) Total
> CONTAINS NUM 113855, Total Acquisition Time
> HAS CONCEPT MOD | CODE G-C171, Laterality

IRRADIATION EVENT X-RAY DATA

NL Rel with Parent VT Concept Name
CONTAINER 113706, Irradiation Event XRay Data
> CONTAINS CODE 111031, Image View
> HAS CONCEPT MOD | CODE 113764, Acquisition Plane
> CONTAINS TEXT 125203, Acquisition Protocol
> CONTAINS TEXT 113780, Reference Point Definition
> CONTAINS UIDREF 113769, Irradiation Event UID
> CONTAINS NUM 122130, Dose Area Product
> CONTAINS NUM 113738, Dose (RP)
> CONTAINS NUM 112011, Positioner Primary Angle
> CONTAINS NUM 112012, Positioner Secondary Angle
> CONTAINS NUM 113790, Collimated Field Area
> CONTAINS CONTAINER 113771, X-Ray Filters
> CONTAINS NUM 113733, KVP
>> CONTAINS CODE 113772, X-Ray Filter Type
>> CONTAINS CODE 113757, X-Ray Filter Materia
>> CONTAINS NUM 113758, X-Ray Filter Thickness Minimum
>> CONTAINS NUM 113773, X-Ray Filter Thickness Maximum
> CONTAINS CODE 113732, Fluoro Mode
> CONTAINS NUM 113791, Pulse Rate
> CONTAINS NUM 113768, Number of Pulses
> CONTAINS NUM 113734, X-Ray Tube Current
> CONTAINS NUM 113748, Distance Source to Isocenter
> CONTAINS NUM 113750, Distance Source to Detector
> CONTAINS NUM 113735, Exposure Time
> CONTAINS NUM 113793, Pulse Width
> CONTAINS NUM 113736, Exposure
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> CONTAINS NUM 113766, Focal Spot Size

> CONTAINS NUM 113742, Irradiation Duration

> CONTAINS CODE 123014, Target Region

> CONTAINS NUM 111631, Average Glandular Dose
> CONTAINS CODE 111632, Anode Target Material

> CONTAINS NUM 111633, Compression Thickness
> CONTAINS NUM 111634, Half Value Layer

> CONTAINS NUM 111636, Entrance Exposure at RP
> CONTAINS CODE 113721, Irradiation Event Type

> CONTAINS DATETIME 111526, DateTime Started

> HAS CONCEPT MOD | CODE G-C171, Laterality

> CONTAINS CODE 111635, X-Ray Grid

> CONTAINS NUM 113751, Table Longitudinal Position
> CONTAINS NUM 113753, Table Height Position

> CONTAINS NUM 113752, Table Lateral Position

> CONTAINS CODE 113876, Device Role in Procedure

7.3. DICOM MPPS MESSAGES

When DICOM Mpps messages are received from the Synapse Dose Adapter, a list of attributes is
stored in records local database. Here below a list of the attributes which are stored and mapped to
local information entities in the database is represented.

Attribute Name Tag Mandatory
Scheduled Step Attributes Sequence 0040,0270 YES
Patient ID 0010,0020 YES
Patient's Sex 0010,0040 NO
Patient's Name 0010,0010 NO
Patient's Birth Date 0010,0030 NO
Performed Procedure Step Description 0040,0254 YES
Performed Procedure Step Start Time 0040,0245 YES
Media Storage SOP Instance UID 0002,0003 YES

Total Number of Exposures 0040,0301 NO
Exposure Dose Sequence 0040,030E NO

Image and Fluoroscopy Area Dose Product 0018,115E NO
Station AE Title 0008,0055 YES

Scheduled Step Attributes Sequence

Attribute Name Tag Mandatory
Accession Number 0008,0050 NO

Study Instance UID 0020,000D YES

Exposure Dose Sequence

Attribute Name Tag Mandatory
Body Part Examined 0018,0015 NO
Exposure Time 0018,1150 NO
Exposure in yAs 0018,1153 NO

KVP 0018,0060 NO

X-Ray Tube Current in yA 0018,8151 NO
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